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System Requirements
Operating System

Windows Server 2003 or 2008

Server

SharePoint Release 3:
- Microsoft Windows SharePoint Services 3.0 or Microsoft Office SharePoint Server 2007
SharePoint 2010:
- Microsoft SharePoint Foundation 2010 or Microsoft SharePoint Server 2010

Browser

Microsoft Internet Explorer 8 or higher
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About the Setup Program
Before installing the product, read the Installing the Product section of the Online Documentation and review KB.12464: Best Practices for Installing Bamboo
Products.
To access the Setup program:
1. Download the self-extracting product EXE from the storefront and save it to a local folder on the SharePoint server.
2. Double-click the product EXE file to extract the contents of the product download.
3. The Setup program will automatically start. To start the Setup program manually, double-click the Setup.bat file in the root of the folder where the
product files were extracted.
The Setup program may look different for different product versions. See examples below of the two Setup programs that are currently in use. Both versions of the
Setup program work the same way.

Note: The minimum screen resolution to view the Setup program is 1024x768.
The Setup program contains links to each product component under the Components header on the left. Click on any of these links to view a description of the
component on the right. The component description contains important information about where to install the component and the required permissions for the
installation account. Read this information carefully before proceeding.
Each product may have several components, which fall into the following categories:
z

Prerequisites: Some products include prequisite components that must be installed before the Bamboo product core components. Not all products will have
prerequisites. Examples of prerequisites include the Shared Assemblies Library, Microsoft AJAX Extensions, and Bamboo AJAX Config.

z

Core Components: The product will include one or more core components that are required for the Bamboo product to work.

z

Optional Items: Optional items provide additional features or functionality but are not required to use the Bamboo product. Not all products will have optional
items. Examples of optional items include the MashPoint Runtime Components and sample ASP.NET applications.

z

Licensing: All products will include the Bamboo Web License Manager or Bamboo License Manager. Licensing is required to activate a product license. It is not
required during 30-day product trials.

z

Help: The Setup program also contains links to the Online Documentation and the Installation and Licensing Quick Start Guide. Links to other product-related
resources, like the Bamboo Knowledge Base, may also be included.

After reviewing the installation location and required installation permissions for a component, click the Install button at the bottom of the Setup screen to install
it. If the product includes multiple components, click the Install button for each component.
Click the Home icon

to return to the Setup main page.

About the extracted product files:
The extracted product files include the file Setup.bat, which launches the Setup program, and may also include the following folders:
z

\[Product].wsp: Contains the solution deployment file for this product. There may be more than one product WSP folder, depending on the
product.

z

\docs: Contains the Installation and Licensing Quick Start Guide.

z

\msi : Contains installation executables for this product.

z

\res: Contains files required by the Setup program.

z

There may be other folders, depending on the requirements for the product.

Installing SharePoint Knowledge Base Solution Accelerator
Read all of the following information before installing SharePoint Knowledge Base Solution Accelerator:
z

Recommendations for a Successful Installation

z

Installation Location

z

Required Installation Permissions

z

Installing SharePoint Knowledge Base Solution Accelerator

Recommendations for a Successful Installation
Follow these guidelines to ensure a successful installation:
1. Back up your system.
2. Make sure that your system meets the requirements listed in System Requirements.
3. Review KB.12464: Best Practices for Installing Bamboo Products before installing SharePoint Knowledge Base Solution Accelerator.
4. Review the Installation Location and Required Installation Permissions before installation.
5. Stop the World Wide Web Publishing Service before installation.
TOP

Installation Location
If you are installing a Bamboo product in a SharePoint farm environment, make sure to start the installation on the correct server. The required installation location
is listed in the Setup program in the description for each component.
Install this component on one of the servers in the SharePoint farm running the Microsoft SharePoint Foundation Web Application service. Refer to System
Settings in SharePoint Central Administration for a list of servers running this service. This component will be automatically deployed to all Web front-end servers
by the SharePoint 2010 Timer service.
TOP

Required Installation Permissions
Required installation permissions are listed in the Setup program in the description for each component. The installation account must have the following
permissions:
z

Member of the local server Administrators group

z

Member of the SharePoint Farm Administrators group

z

Site collection administrator (for automatic feature activation)

TOP

Installing SharePoint Knowledge Base Solution Accelerator
1. If the Setup program is not already running, double-click the Setup.bat file in the root of the product folder to launch it.
2. Select the product component in the Setup program. Verify the installation location and required permissions and then click Install.
3. Click Next to begin the installation. Verify that the system checks pass successfully, then read and accept the End-User License Agreement.
4. In the Deployment Targets screen, select the Web application(s) where you want to install the product. Leave the Automatically activate features option
checked to activate product features during installation. Click Next to begin installation.
Note: If you prefer to activate product features manually after installation, uncheck the Automatically activate features option, then read Manually
Activating the SharePoint Knowledge Base Solution Accelerator for a Site Collection.
5. When installation is complete, review the summary screen to confirm that the product installed successfully. Click Close.
TOP

Installing the Optional Components
Components listed in the Optional Items section are not required for SharePoint Knowledge Base Solution Accelerator to work, but they may provide additional
features or enhanced functionality. To install optional components, click on the component in the Optional Items section and read the descriptive information and
installation requirements. Then, click the Install button for that component, located at the bottom of the screen.
Workflow Start Feature
The Workflow Start Feature allows custom workflow start buttons to be added to the item ribbons in SharePoint 2010. This feature can be used in conjunction with
Workflow Conductor to help automate processes such as approving and publishing articles and comments. See KB.12669 for more information on using Workflow
Conductor with SharePoint Knowledge Base Solution Accelerator.
Installation Location
Install this component on a server in the SharePoint farm running the Microsoft SharePoint Foundation Web Application service. Refer to System Settings in
SharePoint Central Administration for a list of servers running this service. This component will be automatically deployed to all Web front-end servers by the
SharePoint 2010 Timer service.
Required Installation Permissions
The installation account must be a member of the local server Administrators group and a member of the SharePoint Farm Administrators group.
Installation
To install the component, select Workflow Start Feature from the Setup screen and click Install. Follow the prompts in the installation wizard.

TOP

Manually Installing or Uninstalling SharePoint Knowledge Base Solution Accelerator
The following PowerShell scripts are intended for experienced users to manually install or uninstall SharePoint Knowledge Base Solution Accelerator instead of using
the Setup program. For information on using PowerShell, see Microsoft's PowerShell Web site.
The product extraction folder contains two files for manual install and uninstall. They are located in the \misc folder:
z

ManualInstallation.ps1

z

ManualUninstallation.ps1

To manually install SharePoint Knowledge Base Solution Accelerator:
1. Right-click on PowerShell and choose Run as Administrator. You can use Windows PowerShell or SharePoint 2010 Management Shell.
2. Change the directory to "SA05.R2.SP2010.SL/misc folder".
3. Enter ".\ManualInstallation.ps1".
4. Enter the Web application URL. Choose whether you want to automatically activate the features in the site collection.
5. The script file installs Bamboo.Core.wsp and Bamboo.Logging.wsp if they are not already in the solution store.
6. The script file next installs all required components for the product.
To change the script so that it does not ask for the Web application URL:
Edit the script file and change the following lines:
# write-host "Enter the Web application URL where you need to deploy the solution"
[string]$WebApplicationUrl = Your Web application URL
# write-host "Do you want Automatic Feature Activation (Yes or No)"
$automaticFeatureActivate = Yes or No
TOP

To manually uninstall SharePoint Knowledge Base Solution Accelerator:
1. Run PowerShell as administrator.
2. Change the directory to "SA05.R2.SP2010.SL/misc folder".
3. Enter ".\ManualUninstallation.ps1".
4. The script file does not uninstall Bamboo.Core.wsp and Bamboo.Logging.wsp. These solutions will remain in the solution store.
5. The script file uninstalls all required components for the product. Note: The uninstall script does not deactivate the features for each package before removing
it. If you do not want to reinstall these packages at a later time, deactivate each feature manually before removing the solution.
TOP

Manually Activating the Product Features for a Site Collection
Product feature activations can be done automatically at the site collection level when SharePoint Knowledge Base Solution Accelerator is installed. There are
several reasons why you may need to manually activate (or deactivate) Bamboo product features:
z

You opted out of automatic feature activation during installation.

z

You add a new site collection and want to add Bamboo features to it.

z

You want to remove Bamboo product features from an existing site collection.

To manually activate (or deactivate) Bamboo product features, follow the instructions below.
Note: You must be a SharePoint site collection administrator to activate or deactivate features. Site collection administrators are assigned in SharePoint Central
Administration.
1. Install SharePoint Knowledge Base Solution Accelerator on the SharePoint server.
2. From the top-level site, navigate to Site Actions > Site Settings > Site Collection Administration > Site Collection Features.
3. Click Activate (or Deactivate) to activate (or deactivate) the following features for the entire site collection:
z

Bamboo KB Admin Site Template R2

z

Bamboo KB Client Site Template R2

z

Bamboo KB Accelerator Reporting Web Part

z

Bamboo Knowledge Base Accelerator

z

Bamboo Navigators Web Parts

z

Bamboo SharePoint Secure Trim Web Part

z

Bamboo Data-Viewer Web Part

z

Bamboo Group Redirect

z

Conductor KB Comment Approval (available if you have installed the optional Workflow Start Feature)

z

Conductor Submit New KB Article (available if you have installed the optional Workflow Start Feature)

Creating the Knowledge Base Administration Site (Bamboo KB Admin Site Template)
You must have the appropriate permissions to create sites within your SharePoint site collection in order to create the Bamboo KB Admin site.
1. From the top-level site, select Site Actions > Site Settings > Site Administration > Sites and Workspaces, or select Site Actions > New Site.

2. Click Create.

3. Under Blank & Custom, select the Bamboo KB Admin Site Template.

4. Give the site a Title and a Web Site Address.
5. Click Create and wait while the KB Admin site is created.

Configuring the Bamboo KB Admin Site Template
The KB Admin site provides the following features:
z

Use the KB Picture Library to upload images, if necessary.

z

Answer pending questions in Pending Questions.

z

In Article Control, create new articles and manage existing ones.

z

Use Category Control to create and manage categories for your KB articles.

z

Approve and manage comments on articles with Comment Control.

For more information about the lists, libraries and other content contained in the KB Admin site template, read About the KB Accelerator Sites, Lists and Web Parts.
Read Configuring the Bamboo KB Admin Web Parts to configure the KB Admin site.
Choosing a Bamboo KB Client Site Template
There are two KB Client site templates to choose from:
z

KB Client Site Template - Team Site: a Bamboo KB Client site based on a standard SharePoint team site

z

KB Client Site Template - Meeting Workspace: a Bamboo KB Client site based on a standard SharePoint meeting workspace

There are only minor differences in the configuration of the two site templates. Choose the one that is best for your SharePoint environment.

The Bamboo KB Client Site Template - Team Site displays the navigation on the left in the Quick Launch bar.

The Bamboo KB Client Site Template - Meeting Workspace displays the navigation using tabs via SharePoint Navigators on the top of the page.

Modifying the Site Navigation
KB Client Site Template - Team Site: You can change the order in which the links are displayed as well as the names of the links for the Home, Search, Ask a
Question and Tag Cloud links. It is recommended that you do not change the order of the Home link. Do not change the site paths. To edit the links, go to Site
Actions > Site Settings > Look and Feel > Quick Launch. Click

next to the item you want to edit in order to make your changes.

KB Client Site Template - Meeting Workspace: Use the SharePoint Navigators List to change the order of the tabs. Access the list by selecting Site Actions >
View All Site Content > Bamboo Navigators. You can change the names of the tabs. Do not change the site paths of the tabs. See the SharePoint Navigators
online documentation for more information.

Creating the Knowledge Base Client Site (Bamboo KB Client Site Template)
You must have appropriate permissions to create sites within your SharePoint site collection in order to create the Bamboo KB Client site.
1. From the top-level site, click Site Actions > Settings 7 Site Administration > Sites and Workspaces, or select Site Actions > New Site.

2. Click Create.

3. Under Blank & Custom, choose the KB Client site template:
z

Bamboo KB Client Site Template - Meeting Workspace

z

Bamboo KB Client Site Template - Team Site

Read Choosing a Bamboo KB Client Site Template to determine which template to use.
4. Give the site a Title and a Web Site Address.
5. Click Create and wait while the KB Client site is created.

Bamboo KB Client Site Template - Team Site

Bamboo KB Client Site Template - Meeting Workspace

Configuring the Bamboo KB Client Site Template
The KB Client site provides the following features:
z

Use the Search option to search KB articles.

z

Select Ask a Question to submit a new question.

z

Use the Tag Cloud to assign tags to articles.

For more information about the lists, libraries and other content contained in the KB Client site template, read About the KB Accelerator Sites, Lists and Web Parts.
See Configuring the Bamboo KB Client Web Parts to configure the KB Client site.
Upgrading SharePoint Knowledge Base Solution Accelerator
Click a section below to upgrade SharePoint Knowledge Base Solution Accelerator from previous versions to R2.0. This product can also be migrated to SharePoint
2010 from SharePoint 2007.
z

What Has Changed in SharePoint Knowledge Base Solution Accelerator R2.0

z

Upgrading SharePoint Knowledge Base Solution Accelerator to R2.0 or Newer

z

Optional Manual Customizations for SharePoint Knowledge Base Solution Accelerator R2.0

z

Migrating SharePoint Knowledge Base Solution Accelerator to SharePoint 2010 From SharePoint 2007

What Has Changed in SharePoint Knowledge Base Solution Accelerator R2.0
In R2.0 the following Web Parts were added:
z

Data-Viewer Web Part: This allows articles to be displayed in grid view and for filtering and sorting.

z

Group Redirect Web Part: This allows Knowledge Base Administrators to redirect users to the KB Client site if end users try to access the KB Admin site.

z

SharePoint Navigators: This allows the KB Admin and KB Client sites to be centralized in one location.

z

SharePoint Secure Trim Web Part: This allows Administrators to set permissions in batches on the articles and categories.

A JavaScript Bamboo_KB_Articles_2010.js is added to allow Administrators to adjust the width of the Article Category and Related Articles columns.
The optional Workflow Start Feature allows Administrators to customize and add workflow start buttons to the item ribbons in SharePoint 2010, enabling
Administrators to integrate SharePoint Knowledge Base Solution Accelerator with Workflow Conductor R1.6 to create automated processes for publishing articles
and comments. They can also use SharePoint’s out-of-the-box workflow buttons.
The Bamboo KB Client Configuration List is added to the KB Client site. This list allows users to select the option to use a specific account to access data on the
KB Admin site and to allow anonymous access.
New sections are added to the left navigation:
z

Reporting: Four reports are available for Administrators to analyze article usage.

z

Authors: My Articles and All Articles are available under the Authors section to allow editors to manage their articles.

z

Manage Articles and Category Permissions: This section allows Administrators to manage the permissions for the articles and categories in batches.

New columns are added:
z

Expiration Date column is added to the Bamboo KB Articles list.

z

Need KB column is added to the Customize Bamboo Article Questions and Answers Discussion Board.

Upgrading SharePoint Knowledge Base Solution Accelerator to R2.0 or Newer
I. Run the upgrade from the Setup program.
1. Stop the World Wide Web Publishing Service (W3SVC).
z

From the Start menu, select Administrative Tools > Services.

z

Right-click on the World Wide Web Publishing Service and select Stop.

2. Select the SharePoint Knowledge Base Solution Accelerator Core Component and click Install.

3. Click Next and wait while the system check is completed. Select the Upgrade/Repair Existing and Install New option, then click Next.

4. Wait while the components are upgraded and the new components (SharePoint Navigators, Group Redirect Web Part, Data-Viewer Web Part, SharePoint Secure
Trim Web Part, etc.) are added.
5. Review the summary screen to ensure that the upgrade was successful, then click Close.

6. Restart the W3SVC.
TOP

II. Manually upgrade the KB Admin and KB Client sites.
Warning:
When the KB Client site is first displayed in the browser, you will see the following errors until the KB Admin and KB Client sites have been manually configured.

When you first access the KB Admin site after the upgrade, you should see the following:
z

New sections added to the left navigation pane: Workflow Configuration List (optional), Reporting, Authors, and Manage Articles and Category Permissions.

z

New JavaScript (Bamboo_KB_Articles_2010.js) and Secure Trim Web Page are added to the Shared Documents Library.

z

New Bamboo Navigators List and KB Admin Upgrade History List.

Follow the steps below to upgrade the KB Admin site:
1. From the KB Admin site home, edit the KB Tree View Web Part. In the tool pane, click Upgrade KB Admin site and content.

After the upgrade is completed, a message is displayed indicating that the upgrade was successful. The Upgrade button in the tool pane will then be grayed out. The
KB Admin site's content is stored in the KB Admin Upgrade History list.

Click Apply and then OK. Note: During the upgrade, if Internet Information Services (IIS) is restarted, it will interrupt this upgrade process. Click on the
Upgrade button to run the upgrade again.
2. From the Quick Launch, click All Site Content, then click KB Admin Upgrade History List. The status should be Success.

3. The upgrade process for the KB Admin site is complete.
Follow the steps below to upgrade the KB Client site:
1. From the KB Client site home, edit the KB Tree View Web Part. In the tool pane, click Upgrade KB Client site and content.
After the upgrade is completed, a message is displayed indicating that the upgrade was successful. The Upgrade button in the tool pane will then be grayed out. The
KB client site's content is stored in the KB Client Upgrade History list.

Click Apply and then OK. Note: During the upgrade, if Internet Information Services (IIS) is restarted, it will interrupt this upgrade process. Click on the
Upgrade button to run the upgrade again.
2. Navigate to the KB client site's Lists by clicking All Site Content > Lists. Then click KB Client Upgrade History List. The status should be Success.

3. In R2.0, the application is no longer set up using the revert application pool to access data from the admin site. You can either allow groups to access certain
data and lists in the KB Admin site, or you can use a specific account to access data. The configuration for either option is configured in the new Bamboo KB Client
Configuration list. The option is defaulted to Yes, where an account is needed to add to this list, or you can change the option to No. (Note: This is the reason
why you see the errors mentioned above—an account was not yet configured to access the data from the KB Admin site.)

Navigate to the KB Client site's lists by clicking All Site Content > Lists. Then click the Bamboo KB Client Configuration List. Select Use a Designated
Account to Access Data if you want to use a designated account to search and display articles from the KB Admin site, or if you want to allow anonymous access
to the KB Client site. In the Access Account field, enter the account that will be used to access data from the KB Admin site. You must first select the Use a
Designated Account to Access Data option. Click Save. To add this account to the Read-Only access group, see Security Trimming for more information.

TOP

III. Manually configure the Web Parts in the KB Admin and KB Client sites.
To manually configure the Web Parts on the KB Admin site:
1. For the Manage Articles, Manage Categories and Approve & Manage sections, modify the KB Search Web Part:
z

In the tool pane, click KB Search Web Part Settings. Note: You must disable pop-up blockers for the site to display the Web Part Settings.

z

In the Web Part Settings, select Search Results Configuration. Under Search Results Options, select Display both search criteria and search results,
only if Search All Columns is enabled in the Search Criteria Configuration. Unchecking this option replaces the search form with the search results. If users
are allowed to search in all columns, where the server's search scope is set up, the option "Use SharePoint Search results view" will replace the KB Search
results grid view with the SharePoint Server Search results view. If desired, choose to export search results to Microsoft Excel or to print the results. See
Configuring the KB Search Web Parts for more information.

z

Click Save & Close to close the Web Part Settings, then click Apply and then OK to stop editing the Web Part.

To manually configure the Web Parts on the KB Client site:
1. Click the Search link on the left navigation. Modify the KB Search Web Part:
z

In the tool pane, click KB Search Web Part Settings. Note: You must disable pop-up blockers for the site to display the Web Part Settings.

z

In the Web Part Settings, select Search Results Configuration. Under Search Results Options, select Display both search criteria and search results,
only if Search All Columns is enabled in the Search Criteria Configuration. Unchecking this option replaces the search form with the search results. If users
are allowed to search in all columns, where the server's search scope is set up, the option "Use SharePoint Search results view" will replace the KB Search
results grid view with the SharePoint Server Search results view. If desired, choose to export search results to Microsoft Excel or to print the results. See
Configuring the KB Search Web Parts for more information.

z

Click Save & Close to close the Web Part Settings, then click Apply and then OK to stop editing the Web Part.

TOP

Optional Manual Customizations for SharePoint Knowledge Base Solution Accelerator R2.0
Note: The following customizations are optional.
I. Centralize the tabs for the KB Admin and KB Client sites.
The KB Admin and KB Client sites exist as two individual sites. You can create two tabs in one centralized place for easy access to each site by following the steps
below:
Note: The centralized tabs are available with the site templates in R2.0. With older site templates such as R1.5, you are required to perform some manual steps.
1. Open Microsoft SharePoint Designer 2010. For more information, see this this blog post on modifying master pages in SharePoint Designer.
2. Open v4.master from the \_Catalogs\masterpage folder within the admin site where SharePoint Knowledge Base Solution Accelerator is installed. Make sure
that SharePoint Designer is in Split mode.

3. Enter the following line after /asp:ContentPlaceHolder and before div id="s4-statusbarcontainer": <div id="bs-NavigatorTabStrip"></div>.

Insert the Bamboo Navigators TabStrip into the <div> tag.

Note: If the site was not created as the top site in the site collection, do not insert the Web Part into the master page because you will not be able to
configure the Web Part. Instead, see Step 4 below.
4. Open the site in the browser and use the ribbon to add the Bamboo Navigators TabStrip to the home page.

Configure the Web Part as follows:
z

Select List: Bamboo Navigators

z

Select View: Top

z

Menu Title: Menu Title

z

Description: Description

z

URL Link: URL

z

Parent Menu: Parent Menu

z

Sort Order: Sort Order

z

URL Icon: Icon URL

z

Select Skin: Default

To hide the title of the Bamboo Navigator TabStrip, select None for Chrome Type under Appearance.

5. Open the home.aspx page in SharePoint Designer from the site pages folder. Copy Bamboo Navigators TabStrip and paste the Web Part into the <div> tag on
the master page.
6. Insert the following lines after <div id="bs-clearright"></div> and before <div id="s4-topheader2" class="s4-pr s4-notdlg">:
<td class="s4-socialdata-notif">
<SharePoint:DelegateControl ControlId="GlobalSiteLink3" Scope="Farm" runat="server"/>
</td>
</tr>
</tbody>
</table>
<div>
<div>
7. Insert the following style into the page below line <SharePoint:SPHelpPageComponent Visible="false" runat=server"/> and above line </head>:
<style type="text/css">
.menu-horizontal{
display:none;
}
#bs-clearright{
clear:right;
}
#bs-NavigatorTabStrip{
display:table;
padding-left:10px;
}
.s4-recentchanges{
display: none;
}
</style>
8. Switch to Design mode and save the master page.

9. Open the site in the browser and delete the Bamboo Navigators TabStrip from the home.aspx page.
10. Follow the steps above to add the Bamboo Navigator TabStrip to the KB Client site using SharePoint Designer.
11. Change the URL of the KB Client site on the KB Admin site.
z

From the KB Admin site, click All Site Content, then select the Bamboo Navigators list.

z

Click on the KB Client item and edit the URL. The URL should be the relative path to the KB Client site, such as ../kbclient/default.aspx.

z

The two tabs should now be displayed:

12. Change the URL of the KB Admin site on the KB Client site.
z

From the KB Client site, navigate to the KB Client site's lists by clicking All Site Content > Lists.

z

Select the Bamboo Navigators list, then click on the KB Admin item and edit the URL. The URL should be the relative path to the KB Admin site, such
as ../kbadmin/default.aspx. If desired, you can hide the KB Admin tab from end users by changing the permission for the KB Admin item.
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II. Redirect end users to the KB Admin site.
If desired, add the Group Redirect Web Part to the KB Admin site home to redirect end users from the KB Admin site.
z

Edit the KB Admin home page. Use the ribbon to add the Group Redirect Web Part by selecting Insert Web Part > Bamboo Solutions > Bamboo Group
Redirect Web Part.

z

Edit the Web Part and configure it according to the instructions in Configuring the KB Admin Site. To hide the Web Part, select the Hidden option in the tool
pane under Layout.

z

Click Apply and then OK to save your changes.

TOP

III. Manually change the width of the Related Articles and Article Category fields.
The width of the Related Articles and Article Category fields can be modified using SharePoint Designer so that full article titles and categories are visible.
To modify the width of the fields:
1. Open the KB Admin site using SharePoint Designer 2010.
2. Open EditForm.aspx and NewForm.aspx under /Lists/Bamboo KB Categories/ and /Lists/Bamboo KB Articles/.

3. Use the ribbon to select Insert > Web Part > Media and Content > Content Editor.

4. Right-click on the Web Part and select Web Part Properties. Under Content Link, click on
Bamboo_KB_Articles_2010.js. Click OK and save the page.

and browse to Shared Documents >

5. Return to the KB Admin site and navigate to the Shared Documents Library. Click Bamboo_KB_Articles_2010.js to download it to a local folder. Use Notepad
to edit and change the var maxLimitWidth value to your desired points, such as from 100 to 250. Save the file and upload it to the Shared Documents
Library. The Related Articles and Article Category fields are now widened.

TOP

Migrating SharePoint Knowledge Base Solution Accelerator From SharePoint 2007 to SharePoint 2010
SharePoint Knowledge Base Solution Accelerator can be migrated from SharePoint 2007 to SharePoint 2010. See KB.12630: How to Migrate Bamboo Products From
SharePoint 2007 to SharePoint 2010 for more information.
TOP

Uninstalling SharePoint Knowledge Base Solution Accelerator components
To uninstall SharePoint Knowledge Base Solution Accelerator:
1. Stop the World Wide Web Publishing Service (W3SVC).
z

From the Start menu, click Administrative Tools > Services.

z

Right-click on World Wide Web Publishing Service and select Stop.

2. Double-click the Setup.bat program included in the product download ZIP file.
3. From the Setup program, select the SharePoint Knowledge Base Solution Accelerator component, then click Install.
4. Click Next and allow the program to perform the system checks again. Click Next.
5. Select Remove All and click Next. Wait while the components are uninstalled.
6. Click Next and review the summary to make sure that the product was uninstalled successfully.
7. Restart the World Wide Web Publishing Service.
Locating the Error Log File(s)
If you encounter any errors while installing or using KB Accelerator, refer to the error logs located on the SharePoint server in:
<drive>:\WINDOWS\Temp\BambooSolutions\bsc_bamboo_%processid.log
The error log contains details of any failures that may have occurred during the product installation. It can contain helpful information that allows you to selectively
correct problems in order to later re-run the installation successfully.
Installed Files
The table below lists the files and where they are installed as part of KB Accelerator's installation package.
Each product has a Bamboo.ProductName.Core.dll. This core.dll contains shared assemblies such as Bamboo.Logging.dll, Bamboo.Licensing.dll and
Bamboo.Provisioning.dll. All Bamboo products use these shared assemblies, which are installed under the Bamboo.ProductName.Core.dll in the GAC. Each
product's Core.dll contains these shared assemblies so that each product can be removed or rolled back without affecting other Bamboo products. For example, if
both KB Accelerator and the Calendar Plus Web Part are installed in the same farm, the Calendar Plus Web Part can be uninstalled or rolled back and KB Accelerator
will continue to function without any issues.
Filename

Type

Purpose

Bamboo.KBAccelerator.dll

Assembly

Solution Accelerator Assembly installed in the
GAC

Bamboo.BatchUpdateItemPermission.Core.dll

Assembly

Web Part Assembly installed in the GAC

Bamboo.DataViewDataSourceControl.dll

Assembly

Web Part Assembly installed in the GAC

Bamboo.GroupRedirect.Core.dll

Assembly

Web Part Assembly installed in the GAC

Bamboo.KBAccelerator.Core.dll

Assembly

Web Part Assembly installed in the GAC

Bamboo.KBAcceleratorPack.dll

Assembly

Web Part Assembly installed in the GAC

Bamboo.KBAcceleratorPack.Core.dll

Assembly

Web Part Assembly installed in the GAC

Bamboo.KBReporting.Core.dll

Assembly

Web Part Assembly installed in the GAC

Bamboo.Navigators.dll

Assembly

Web Part Assembly installed in the GAC

Bamboo.Navigators.Core.dll

Assembly

Web Part Assembly installed in the GAC

Bamboo.SPGridView.Core.dll

Assembly

Web Part Assembly installed in the GAC

Bamboo.Telerik.Config.dll

Assembly

Web Part Assembly installed in the GAC

Bamboo.WordExtraction.dll

Assembly

Web Part Assembly installed in the GAC

Bamboo.WordExtraction.Core.dll

Assembly

Web Part Assembly installed in the GAC

Bamboo.KBEventReceiver.dll

Assembly

Web Part Assembly installed in the GAC

Bamboo.KBFullTextSearch.dll

Assembly

Web Part Assembly installed in the GAC

Bamboo.BatchUpdateItemPermission.dll

Assembly

Web Part Assembly installed in the Bin

Bamboo.GroupRedirect.WebPart.dll

Assembly

Web Part Assembly installed in the Bin

Bamboo.KBAReporting.dll

Assembly

Web Part Assembly installed in the Bin

Bamboo.SPGridView.dll

Assembly

Web Part Assembly installed in the Bin

Bamboo.Logging.dll

Assembly

Web Part Assembly installed in the GAC

Bamboo.UI.Licensing.dll

Assembly

Web Part Assembly installed in the GAC

Bamboo.UI.Licensing.Core.dll

Assembly

Web Part Assembly installed in the GAC

Bamboo.RussellMason.Web.Application

Assembly

Web Part Assembly installed in the GAC

Telerik.Web.UI.dll

Assembly

Web Part Assembly installed in the GAC

Bamboo.Core.dll

In case you need to install this component
manually.

SA05.KBAccelerator.wsp

In case you need to install this Solution
Accelerator manually.

HW55.BambooNavigators.wsp

In case you need to install this Web Part
manually.

SA05.KBReporting.wsp

In case you need to install this component
manually.

KBAcceleratorPack.wsp

In case you need to install this component
manually.

HW37.Dataviewer.wsp

In case you need to install this component
manually.

HW12.Bamboo.GroupRedirect.wsp

In case you need to install this component
manually.

Bamboo.WordExtraction.wsp

In case you need to install this component
manually.

Bamboo.Telerik.Config.wsp

In case you need to install this component
manually.

Bamboo.StartWorkFlow.wsp

In case you need to install this component
manually.

Bamboo.Logging.wsp

In case you need to install this component
manually.

Bamboo.BatchUpdateItemPermission.wsp

In case you need to install this component
manually.

Bamboo.Web.Licensing.wsp

In case you need to install this component
manually.

TOP

Updating the web.config File
The installation process also updates the web.config file. If you cannot install the Solution Accelerator using the automated process and plan to install it manually,
add the following to your web.config file:
<SafeControl Assembly="Bamboo.Navigators, Version=1.0.0.0, Culture=neutral, PublicKeyToken=2cc91efae2d531be" Namespace="Bamboo.WebParts"
TypeName="*" Safe="True" SafeAgainstScript="True" />
<SafeControl Assembly="Bamboo.KBAccelerator, Version=1.0.0.0, Culture=neutral, PublicKeyToken=2cc91efae2d531be" Namespace="Bamboo.WebParts"
TypeName="*" Safe="True" SafeAgainstScript="True" />
TOP

Code Access Security
The following PermissionSet and CodeGroup markup may be installed by wppackager.
Class

Name

Version

Public Key Blob

StrongNameMembershipCondition

Bamboo.KBAccelerator

1

0x002400000480000094000000060200000024000052534131000400000100010099189C71722AEBE6ADF12BF1FF2828C9DC20BFB7

StrongNameMembershipCondition

Bamboo.Licensing

1

0024000004800000940000000602000000240000525341310004000001000100A76FDA645D3FCF461C428E0112290EABE802951AFA

If you must install KB Accelerator manually, the following security in order to implement a custom security policy file:
Permission

Custom Setting

System.Web.AspNetHostingPermission

Level="Medium"

System.Security.Permissions.FileIOPermission

Unrestricted="true"

System.Security.Permissions.RegistryPermission

Unrestricted="true"

System.Security.Permissions.ReflectionPermission

Flags="3"

SecurityPermission

Unrestricted="true"

SharePointPermission

ObjectModel="True"
UnsafeSaveOnGet="True"
Impersonate="True"

WebPartPermission

Connections="True"

System.Configuration.ConfigurationPermission

Unrestricted="true"

System.Net.WebPermission

Unrestricted="true"

System.Security.Permissions.EnvironmentPermission

Read="TEMP;TMP;USERNAME;OS;COMPUTERNAME"

To set up your own custom security policies, refer to the following links for more information:
z

Bamboo Solutions FAQ (opens in a PDF)

z

Security and Protection for SharePoint Server 2010

z

Security and Protection for SharePoint Foundation 2010

TOP

Configuration
z

Security Trimming

z

Configuring the KB Admin Site

z

Configuring the KB Client Site

z

Configuring the KB Search Web Parts

z

Using Relative Paths

z

Localizing SharePoint Knowledge Base Solution Accelerator

Security Trimming
Click a section below for more information on configuring security in SharePoint Knowledge Base Solution Accelerator:
z

Hiding the KB Admin Site

z

Choosing to Use a Designated Account to Access Data

z

Choosing Not to Use a Designated Account to Access Data

In general, users should follow SharePoint security trimming when setting up user permissions. Read the following Microsoft TechNet articles for more information:
z

User Permissions and Permission Levels in SharePoint Foundation 2010

z

User Permissions and Permission Levels in SharePoint Server 2010

Hiding the KB Admin Site
Knowledge Base Administrators can set permissions so that the KB Admin site is completely hidden, and end users can only see the KB Client site.
1. From the KB Client site, select All Site Content > Lists > Bamboo Navigators.
2. Select the KB Admin item. Choose Manage Permissions from the edit context menu. From the ribbon, click Stop Inheriting Permissions.

3. Click OK. You can now create unique permissions.

4. Remove permissions for each group except Owners with Full Control.
z

Select each group that you want to remove.

z

From the ribbon, click Remove User Permissions.

5. The KB Admin site is now hidden from the KB Client site. End users can no longer see the tab.

TOP

Choosing to Use a Designated Account to Access Data
This is the default option for security for the KB Client site. This selection can be made in the Bamboo KB Client Configuration List, located in the KB Client site.
Use this option if:
z

You do not want different SharePoint groups or individual users to have access to the KB Picture Library or KB articles or categories.

z

And/or you want to allow anonymous access to the KB Client site. (Note: Users using an anonymous login will not be able to view list items that have broken
item permissions. A SharePoint access account for anonymous access is required.)

The KB Client site will display an error message after a new KB Client site is created or after an existing KB Client site is upgraded. Before the KB Client site can be
viewed, the KB Client Configuration List must be modified, and an access account must be selected.

Security Configuration for the Access Account for the KB Admin Site
At the KB Admin site, the access account needs Read-Only access to the following:
z

Bamboo KB Articles List

z

Bamboo KB Categories List

z

Bamboo KB Article View Counts List

z

Bamboo KB Rating and Comments List

z

Bamboo KB Tag Cloud List

z

KB Picture Library

The access account needs Limited access to the KB Admin site.

The access account can read KB articles, categories and image links stored in the KB Picture Library. However, the access account does not have access to other KB
Admin site pages, and the account cannot log into the KB Admin site with Limited access. Knowledge Base Administrators can grant the access account a higher
level of permission, such as Read-Only access, if necessary.
Knowledge Base Administrators can allow the access account to read a specific number of articles in the KB Articles and KB Categories lists by breaking list item
permissions and removing the access account's Read-Only permissions for those items. The items in the KB Articles and KB Categories lists that the access account
can read and view in the KB Admin site can be read and viewed in the KB Client site.
Note: If the links to the images in a KB article are stored in a different library or list, then the access account must have permission to read the links from that
library or list.
TOP

Security Configuration for the Access Account for the KB Client Site
Knowledge Base Administrators only need to grant Read-Only access to the KB Client site to other users or groups. The KB Client site also allows anonymous
access. When these SharePoint users/groups or anonymous users access the KB Client site, searching for and displaying KB articles is based on the access account

permission to the KB Admin site.
For example, a Knowledge Base Administrator creates a different SharePoint group and grants Read-Only access to that group in the KB Client site. The following
SharePoint users/groups have Read-Only or higher permissions to the KB Client site. They can access the KB Client site, and they have access to all of the pages in
the site.
z

Forum Lock

z

PMGReview Members

z

PMGReviewVisitorTop

z

SPUser1

z

SPUser3

TOP

Protecting the Identity of the Access Account
Knowledge Base Administrators can remove SharePoint group/users' access to the KB Client Configuration List to ensure that the identity of the access account
remains unknown.
TOP

Choosing Not to Use a Designated Account to Access Data
Knowledge Base Administrators can choose not to use a designated account to access data, but they must make the following configurations:
z

KB Client site: Grant Read-Only access to the KB Client site for SharePoint users/groups

z

KB Admin site: Grant the following permissions to the same SharePoint users/groups:
{

Read-Only access to the following: Bamboo KB Articles List, Bamboo KB Categories List, KB Picture Library

{

Limited access to the KB Admin site

Knowledge Base Administrators can also break item permissions for the KB Articles and KB Categories lists and allow certain groups to see those items. For
example, an Administrator wants to allow the SharePoint group "Sales" to have read access to the Sales KB category and to all KB articles in the Sales category.
The Administrator filters the list view of the KB Articles List to locate these items. Then the Administrator breaks item permissions for each item and removes access
for all SharePoint groups except the Sales group. The Administrator then applies the same permissions in the KB Categories List.
TOP

Security Configuration for Other Lists in the KB Admin Site
The Administrator does not need to grant permission to any user/group from the KB Client site to the following lists:
z

Bamboo KB Configuration List

z

Bamboo Article Questions and Answers

SharePoint Knowledge Base Solution Accelerator reverts to the application pool account to read and write information to these lists. Administrators can stop
inheriting site permissions for these lists and can remove KB Client users/groups' access to these lists as desired.
TOP

Security Configuration for Group Redirect Web Part and Bamboo Navigator TabStrip in KB Admin Site
Knowledge Base Administrators can use the Group Redirect Web Part to redirect end users back to the KB Client site if they try to access the KB Admin site. See
Configuring the KB Admin Site for more information.
TOP

Configuring Site Permission for the KB Admin Site
Knowledge Base Administrators should grant Read-Only access to SharePoint groups with Limited Access so that this group can view the home KB Admin site home
in order to redirect end users to the KB Client site using the Group Redirect Web Part. This redirection is only performed at the KB Admin site home. Users in the
SharePoint group can still access other pages in the KB Admin site if they know the URLs for those pages. The Administrator can choose to remove this group from
other lists and libraries.
TOP

Bamboo Navigator List and Item Permissions in the KB Admin Site
By default, SharePoint groups with Limited Access will have Read-Only permissions to the Bamboo Navigators List. Knowledge Base Administrators are not required
to perform additional steps for this list.
TOP

Bamboo Navigator List and Item Permissions in the KB Client Site
SharePoint groups with Limited Access should already have access to the KB Client site's Bamboo Navigators List. Administrators can remove this group's
permission to the KB Admin site by performing the steps below:

1. From the KB Client site, select All Site Content > Lists > Bamboo Navigators.
2. Click the KB Admin item. From the item context menu, select Manage Permissions.
3. Select the desired users/groups and select Remove User Permissions from the ribbon to break permissions. Members of this group will only see the KB Client
site tab when they log in.

TOP

About the Knowledge Base Solution Accelerator Sites, Lists and Web Parts
For more information about configuring KB Accelerator, read Configuring the Bamboo KB Admin Web Parts and Configuring the Bamboo KB Client Web Parts.
Bamboo KB Admin Site
For the Bamboo KB Admin site, the following lists and Web Parts are used. All of the Web pages for the Web Parts are stored in the Site Pages Document Library.
Name

Type

Description

Configuration

Bamboo KB Configuration List

List

Designates the name of your email
server and the email address from
which emails will be sent

Required

KB Picture Library

Library

Stores all pictures uploaded during
article creation

N/A

Bamboo Article Questions and
Answers

List

A discussion board list that stores
all questions from the KB Client site
and answers from the KB Admin
site through the Answer Questions
link on the Quick Launch bar.

N/A

Bamboo KB Article View Counts

List

Determines the number of views
for each article in the Knowledge
Base. Do not modify this list.

No. Do not modify this list.

Bamboo KB Articles

List

Stores all articles created for the
Knowledge Base. Uses content
approval to restrict articles from
being published before they are
reviewed or approved. Articles are
published to the KB Client when
the Status column is set to Publish.
The Status column must be set
manually and does not require the
Content Approval Status to be set
to Approved in order to publish the
item. The Content Approval feature
in this instance is meant to be a KB
Administrator reviewing tool only.

N/A

Bamboo KB Categories

List

Stores the categories used to
organize the Knowledge Base.

N/A

Bamboo KB Ratings and Comments

List

Stores all ratings and comments for
each article submitted by KB Client
users along with a status (i.e.
Submitted, Rejected, Published) so
the KB Admin can review the
submitted comments and
determine which comments are
posted to the KB Client site.

N/A

Bamboo KB Tag Cloud

List

Stores all tags created for article
association, the number of times
the tag has been used and in which
articles it has been associated.

N/A

Bamboo KB Answer Questions

Web Part

Allows KB Administrators to post
the answer to enduser questions
in the Bamboo Article Questions
and Answers discussion board
while at the same time emailing
the answer to the end user.

Required

Bamboo Category Search

Web Part

Allows KB Administrators to search
article categories using specific
criteria.

Required

Bamboo KB Search

Web Part

Allows KB Administrators to search
articles or comments and ratings to
determine their existence, their
publishing status and article
content approval status.

Required

Bamboo KB Tree View

Web Part

Displays the category tree on the
Home page for navigating the
Knowledge Base as well as the
Most Popular Articles list and the
Latest Additions list.

Required

Bamboo KB Client Site
All of the Web Parts used in the KB Client sites (both Team Site and Meeting Workspace sites) need to be configured to point to lists in the KB Admin site.
The KB Client site uses lists from the KB Admin site.
For the Bamboo KB Client site, the following Web Parts are used:
Name

Type

Description

Configuration

Bamboo KB Ask Question

Web Part

Allows users to enter and submit a
question to KB Administrators.

Required

Bamboo KB Display Article

Web Part

Allows the article content to be
displayed in a userfriendly format
that includes the ability to print
and email the article.

Required

Bamboo KB Search

Web Part

Allows users to search for specific
article content or ratings and
comments.

Required

Bamboo KB Tree View

Web Part

Displays the category tree on the
Home page for navigating the
Knowledge Base as well as the
Most Popular Articles list and the
Latest Additions list.

Required

Bamboo KB Tag Cloud

Web Part

Displays a list of top tags (i.e.
articles with the most views that
have these tags associated with
them) in a tag cloud on the Tag
Cloud tab.

Required

SharePoint Navigators (Meeting
Workspace site template only)

Web Part

Used for the tabs on the Meeting
Workspace site template only.

Optional

Bamboo Navigators (Meeting
Workspace site template only)

List

Used to create the tabs in the
Meeting Workspace site template
only. This list is prepopulated with
data.

Optional

Configuring the KB Admin Site
The KB Admin and KB Client sites are actually tabs located in the same site for easy, centralized access. Configure the KB Admin site before using it.
Click on a section below for more information:
z

Creating the KB Admin Site

z

Configuring the KB Client Site URL

z

Configuring the Group Redirect Web Part

z

Configuring the KB Article Search Web Part

z

Configuring the KB Category Search Web Part

z

Configuring the KB Comment Search Web Part

z

Configuring the KB Configuration List

z

Configuring the KB Tree View Web Part

z

Configuring the KB Answer Questions Web Part

z

Configuring the Security Trimming Web Part

Creating the KB Admin Site
To create the KB Admin site:
1. In the top site of the site collection where you want to create the KB Admin site, navigate to Site Collection Features and activate the KB Site Templates
features.

2. Select Site Actions > New Site.
3. Under Sites, select the Bamboo KB Admin.R2 site template. Give the site a name and a URL, then click Create.

TOP

Configuring the KB Client Site URL
In order to centralize the KB Admin and KB Client sites, the KB Client site URL must be changed in the KB Admin site before the KB Client site can be configured or
used. Note: If you have upgraded from a previous version of SharePoint Knowledge Base Solution Accelerator, existing sites are not centralized. You must manually
modify the pages using SharePoint Designer.
To change the URL for the KB Client site:
1. From the KB Admin tab, click All Site Content. Under Lists, select Bamboo Navigators, then click KB Client.
2. Click Edit Item. In the URL field, enter the absolute or relative path for the KB Client site, such as ../kbclient/default.aspx. Bamboo recommends using relative
paths. Do not modify the Titles of the list items in the Bamboo Navigators List. Doing so will affect the Bamboo KB Tree View Web Part.
To manually modify the pages to create centralized KB Admin and KB Client sites:
These steps require manually modifying the pages using SharePoint Designer and adding the Bamboo Navigator Tab Strip.
1. Open SharePoint Designer. See this blog post for information on using SharePoint Designer to modify master pages.
2. Open v4.master from the Allfiles\_Catalogs\masterpage folder within the site where SharePoint Knowledge Base Solution Accelerator is installed.

3. Insert the Bamboo Navigator Tab Strip Web Part into the master page.
z

Under Customization, select Edit File.

z

From the ribbon, select Insert > Web Part > Bamboo Navigator TabStrip.

z

Configure the Web Part by right-clicking on it and selecting Web Part Properties.

z

Configure the Web Part as indicated below. Click OK.
{

Select List: Bamboo Navigators

{

Select View: Top

{

Menu Title: Menu Title

{

Description: Description

{

URL Link: URL

{

Parent Menu: Parent Menu:

{

Sort Order: Sort Order:

{

URL Icon: Icon URL

{

Select Skin: Default

z

Save the master page.

z

Follow the instructions above to change the URL for the KB Client site.

z

Return to SharePoint Designer and view the Web Part Properties. Select Navigators View for the Select View option.

z

To hide the title of the Bamboo Navigator TabStrip, select None for Chrome Type under Appearance.

TOP

Configuring the Group Redirect Web Part

The Group Redirect Web Part enables security trimming for the KB Admin site. This is an optional step that allows Knowledge Base Administrators to prevent end
users from accessing the KB Admin site. End users who attempt to access the KB Admin site will automatically be redirected back to the KB Client site.
To configure the Group Redirect Web Part:
1. From the KB Admin site, select Site Actions > Edit Page.
2. Edit the hidden Bamboo Group Redirect Web Part, located at the top of the page.
3. In the tool pane under Group Redirect Configuration, provide the information listed below, then click Connect.
z

a domain name

z

an account name

z

a password

4. Set the rules for the redirect criteria:
z

Choose Is or Not depending on whether you want the group you add to be included or excluded from the redirect. For example, if you select Is + SP
Group + [Site] Visitors, then the [Site] Visitors SharePoint group will be redirected away from the KB Admin site. If you select Not for this same
criteria, then all other groups except the [Site] Visitors will be redirected to the KB Client site.

z

Select SP Group or AD Group and choose the group to be included in the rule. To add more groups, click Add More Groups and select AND or OR.

z

Enter the site URL for the KB Client site. Users who do not have permission to view the KB Admin site will be redirected to the KB Client site.

5. Click Add More Criteria to add additional criteria rules, if desired.
Configuring the Group Redirect Web Part is optional. If you do not want to use the Group Redirect Web Part, you can delete the Web Part from the page. Or, in the
tool pane under Redirect Rules Criteria, choose None for the group, then enter "." in the Redirect to field.
See the Group Redirect Web Part online documentation for more information.
TOP

Configuring the KB Article Search Web Part
The KB Article Search Web Part is used to search for KB articles. The Web Part is located by clicking the Manage Articles link under Article Control on the lefthand navigation bar in the KB Admin site.
1. From the Quick Launch bar, click the Manage Articles link.
2. Edit the Web Part by clicking the arrow located in the top right corner of the Article Search title bar and selecting Modify Shared Web Part.
3. In the tool pane, click the KB Search Web Part Settings button to display the Web Part Settings page. Note: You must disable pop-up blockers for the site to
display the Web Part Settings.
4. Configure the Web Part Settings. See Configuring the KB Search Web Parts for more information.
5. Click Save & Close, then click Apply and then OK to save your changes.
TOP

Configuring the KB Category Search Web Part
The KB Category Search Web Part is used to search categories. The Web Part is located by clicking the Manage Categories link under Category Control on the
left-hand navigation bar in the KB Admin Site. Follow the instructions for configuring the KB Article Search Web Part above.
TOP

Configuring the KB Comment Search Web Part
The KB Comment Search Web Part is used to search comments. The Web Part is located by clicking the Approve & Manage link under Comment Control on the
left-hand navigation bar in the KB Admin Site. Follow the instructions for configuring the KB Article Search Web Part above.
TOP

Configuring the KB Configuration List
To configure the KB Configuration List:
1. From the KB Admin site, select All Site Content. Under Lists, select Bamboo KB Configuration List.
2. Edit the KB Default Settings by selecting Edit from the drop-down list, or use the ribbon by selecting Item > Edit Item.
3. Enter the following information:
z

Enter a Title or leave the default title. This is a required field.

z

In the SMTP Server Name field, enter the name of the SMTP server for sending e-mail.

z

In Email From Account, enter the e-mail address that you want displayed in the From field of the e-mail. This address must be in the correct e-mail
address format (i.e. email@domain.com).

z

Leave the Auto Archive Date field blank. This field is reserved for an upcoming feature.

4. Click Save.
TOP

Configuring the KB Tree View Web Part
To configure the KB Tree View Web Part:
1. From the KB Admin site, edit the KB Tree View Web Part.
2. Configure the Web Part:
z

Enter the site URL for the Bamboo KB Admin site: This field is already populated for you with the relative path URL. See Using Relative Paths for
more information on the syntax for relative paths.

z

Select a Display List: This field is already preselected for you with the Bamboo KB Articles list.

z

Select Default View: Select the list view that you would like displayed in the Most Popular Articles list and the Latest Additions list.

z

Show Tree View: Toggles showing the category for navigating the Knowledge Base content.

z

Show Edit Buttons: Toggles showing the Edit button for each article in the Most Popular Articles list and the Latest Additions list.

z

Show Delete Check Boxes: Toggles showing the check boxes used for selecting and deleting articles in the Most Popular Articles list and the Latest
Additions list.

z

Show Most Popular Articles: Toggles showing the Most Popular Articles list, which shows articles that have had the most views.

z

Show Latest Additions: Toggles showing the Latest Additions list, which shows the articles that were recently added to the Knowledge Base.

z

Show All Articles: Select this option to show the All Articles list, which displays all articles in the Knowledge Base with paging according to the
Records per Page value. When you select a category in the tree, the All Articles list shows all articles for that category and all of its subcategories.

z

Records per Page: Enter the number of articles you want listed at a time in the Most Popular Articles list, Latest Additions list and the All Articles
list.

z

Automatically expand level: Choose how many items you want to be displayed by default in the tree view.

z

Enter the URL to the page that contains the Bamboo Display Article Web Part for displaying article content: This field is used for the KB Client
site only. Make sure that you enter a relative path for the URL.

z

Select a Language: Select this option to set the language used on the user interface of this Web Part. See Localizing KB Accelerator for more
information.

3. Click Apply and then OK to save your changes.
TOP

Configuring the KB Answer Questions Web Part
The KB Answer Questions Web Part is located by clicking the Answer Questions link under the Pending Question header on the left-hand navigation bar in the
KB Admin site.
To configure the Bamboo KB Answer Questions Web Part:
1. From the Quick Launch bar, click the Answer Questions link.
2. Edit the Web Part by clicking the arrow located next to the Web Part title bar and selecting Edit Web Part, or use the ribbon to edit the page.
3. Configure the Web Part:
z

Select a Question and Answer List: This is preconfigured to point to the Bamboo Article Questions and Answers discussion board list.

z

Select a Configuration List: Choose a list such as the Bamboo KB Configuration List.

z

Select Picture Library: This is preconfigured to point to the KB Picture Library. This setting allows you to include images in your response back to the
end user and/or the discussion board. These images can be inserted directly into your response and no longer have to be uploaded to a Picture Library
before you can reference them.

z

Show Answer Question Buttons: Toggles showing the Answer Question button next to the question.

z

Show Delete Check Boxes: Toggles showing the check boxes used for selecting and deleting questions in the list.

z

Use SMTP Secure Authenticated Connection: Select this option to enter in credentials for SMTP authentication.
{

User ID: Enter in the user ID.

{

Password: Enter in the password for the user ID.

{

Port: Enter in the port number.

z

Records per Page: Enter the number of questions you want to display at a time in the KB Answer Questions Web Part.

z

Select a Language: Select this option to set the language used on the user interface of this Web Part. See Localizing KB Accelerator for more
information.

4. Click Apply and then OK to save your changes.

TOP

Configuring the SharePoint Security Trimming Web Part
The SharePoint Security Trimming Web Part enables Knowledge Base Administrators to set permissions for articles and categories in batches.
To configure the SharePoint Security Trimming Web Part:
1. From the Quick Launch bar, click Manage Articles and Category Permissions. Edit the Manage KB Articles Permission Web Part or the Manage KB Category
Permission Web Part.
2. In the tool pane, click the SharePoint Secure Trim Web Part Settings button to display the Web Part Settings page. Note: You must disable pop-up
blockers for the site to display the Web Part Settings.
3. In the Web Part Settings page, configure the settings:
z

z

z

z

Search Criteria: Define the behavior for the Web Part according to the conditions below:
{

Site URL That Contains SharePoint List or Library: Enter the relative path to the KB Admin site. Click View List and Libraries to populate the
fields below.

{

Select SharePoint List or Library: Select the Bamboo KB Articles List.

{

Select Column Available for Searching: To make a column searchable, select it in the Available Columns list on the left and click the >>
button to add it to the Selected Columns list on the right. Hold down the SHIFT or CTRL key to select and move more than one column

{

Define How Search Criteria is Joined: If search terms are entered in more than one column, the Search Criteria Join Operators selection
determines how a match is found. Select the OR operator to display items that match any search term. Select the AND operator to display items
only if they match all search terms.

Search Results Configuration: The Search Results Configuration settings define how search results are displayed in the Web Part.
{

Select List View To Display Search Results: Select the All Items list view.

{

Item Limit: Enter the desired number of items to be displayed per page.

Select a Language: To change the language used in the Web Part display and Web Part Settings page, perform the following steps:
{

If your preferred language is something other than English, customize or create a language file using the instructions provided in Localizing
SharePoint Knowledge Base Solution Accelerator.

{

Access the Web Part and click Language Settings in the Preferences section.

{

In the Select a Language drop-down list, select the desired language file.

{

Click the Save & Close button to save the Web Part settings.

{

In the Web Part tool pane, click Apply and then OK to view updates in the Web Part instance.

Online Resources and Support: If you encounter difficulties or need assistance, read the information provided in the Help section of the Web Part
Settings page.

4. Click Apply and then OK to save your changes.
TOP

Configuring the KB Client Web Parts
The KB Admin and KB Client sites are actually tabs located in the same site for easy, centralized access. Configure the KB Client site before using it.
Click on a section below for more information:
z

Creating the KB Client Site

z

Configuring the KB Admin Site URL

z

Configuring the KB Tree View Web Part

z

Configuring the KB Search Web Part

z

Configuring the KB Ask a Question Web Part

z

Configuring the KB Display Article Web Part

z

Configuring the KB Tag Cloud Web Part

Creating the KB Client Site
To create the KB Client site:
1. In the top site of the site collection where you want to create the KB Client site, navigate to Site Collection Features and activate the KB Site Templates
features.

2. Select Site Actions > New Site.
3. Under Sites, select the Bamboo KB Client.R2 site template. Give the site a name and a URL, then click Create.

TOP

Configuring the KB Admin Site URL
In order to centralize the KB Admin and KB Client sites, the KB Admin site URL must be changed in the KB Client site. Note: If you have upgraded from a previous
version of SharePoint Knowledge Base Solution Accelerator, existing sites are not centralized. You must manually modify the pages using SharePoint Designer. See
Configuring the KB Admin Site for more information.
To change the URL for the KB Client site:
1. From the KB Admin tab, click All Site Content. Under Lists, select Bamboo Navigators, then click KB Admin.
2. Click Edit Item. In the URL field, enter the relative path for the KB Client site, such as ../kbclient/default.aspx. Do not modify the Titles of the list items in the
Bamboo Navigators List. Doing so will affect the Bamboo KB Tree View Web Part.
3. Choose which groups/users can access the KB Admin site by setting the permissions for the KB Admin link. In the Bamboo Navigators List, select Manage
Permissions from the edit menu. Select all groups except Home Owners, then click Remove User Permissions from the ribbon.

TOP

Configuring the KB Tree View Web Part
To configure the KB Tree View Web Part:
1. From the KB Client site, edit the Tree View Web Part.
2. Configure the Web Part:
z

Enter the site URL for the Bamboo KB Admin site: Enter the relative path to the KB Admin site and click the green arrow to populate the fields
below.

z

Select a Display List: Select the Bamboo KB Articles list.

z

Select Default View: Select the list view that you want to be displayed in the Most Popular Articles list and the Latest Additions list. The Summary
View is recommended.

z

Show Tree View: Toggles showing the category for navigating the Knowledge Base content.

z

Show Edit Buttons: This option is not available to end users.

z

Show Delete Check Boxes: This option is not available to end users.

z

Show Most Popular Articles: Toggles showing the Most Popular Articles list, which shows articles that have had the most views.

z

Show Latest Additions: Toggles showing the Latest Additions list, which shows the articles that were recently added to the Knowledge Base.

z

Show All Articles: Select this option to show the All Articles list, which displays all articles in the Knowledge Base with paging according to the
Records per Page value. When you select a category in the tree, the All Articles list shows all articles for that category and all of its subcategories.

z

Automatically expand level: Choose how many items you want to be displayed by default in the tree view.

z

Records per Page: Enter the number of articles you want listed at a time in the Most Popular Articles list, Latest Additions list and the All Articles
list.

z

Enter the URL to the page that contains the Bamboo Display Article Web Part for displaying article content: This field is prepopulated with the
relative path to the Display Article Web Part.

z

Select a Language: Select this option to set the language used on the user interface of this Web Part. See Localizing SharePoint Knowledge Base
Solution Accelerator for more information.

3. Click Apply and then OK to save your changes.
TOP

Configuring the KB Search Web Part
To search for articles, configure the KB Search Web Part.
1. From the Quick Launch bar, click the Search link. Edit the KB Search Web Part.
2. In the tool pane, click the KB Search Web Part Settings button to display the Web Part Settings page. Note: You must disable pop-up blockers for the site to
display the Web Part Settings.
3. Configure the Web Part Settings. Note that the URL for the Bamboo Display Articles Web Part is prepopulated. See Configuring the KB Search Web Parts for
more information.
4. Click Save & Close, then click Apply and then OK to save your changes.
TOP

Configuring the KB Ask a Question Web Part
To configure the KB Ask a Question Web Part:
1. From the KB Client site, click Ask a Question. Edit the Ask a Question Web Part.
2. Configure the Web Part:
z

Enter the site URL for the Bamboo KB Admin site: Enter the relative path to the KB Admin site, then click the green arrow to populate the Select a
Question and Answer List drop-down box with the lists from the KB Admin site. See Using Relative Paths for more information on the syntax for
relative paths.

z

Select a Question and Answer List: Select the Bamboo Article Questions and Answers list.

z

Ask a Question: Enter instructive text for end users, such as "Ask a question" or "Enter your question here". This text appears in the top of the Submit a
Question box.

z

Header Text: Enter the instructive text that you want displayed at the top of the Web Part to help users understand how Knowledge Base Administrators
will respond to their questions.

z

Select a Language: Select this option to set the language used on the user interface of this Web Part. See Localizing SharePoint Knowledge Base
Solution Accelerator for more information.

3. Click Apply and then OK to save your changes.
TOP

Configuring the KB Display Article Web Part
The Display Article Web Part allows articles to be viewed in an attractive format. However, the article must be selected and viewed from the Tree View on the KB
Client site home page. End users cannot view articles by navigating to the Display Article Web Part page.

To configure the KB Display Article Web Part:
1. Access the Bamboo KB Display Article Web Part by selecting All Site Content from the KB Client site. Under Document Libraries, select Site Pages >
Display Page. Edit the KB Display Article Web Part.
2. Configure the Web Part:

z

Enter the site URL for the Bamboo KB Admin site: Enter the relative path to the KB Admin site, then click the green arrow to populate the fields
below.

z

Select the KB Articles List: Select the Bamboo KB Articles List.

z

Select the KB Article View Count List: Select the Bamboo KB Article View Counts List.

z

Select the KB Configuration List: Select the Bamboo KB Configuration List.

z

Select the KB Rating and Comments List: Select the Bamboo KB Rating and Comments List.

z

Custom Related Article Information: Create a tabbed section following the article content for custom article information such as Review Date,
Article Categories or custom columns of your choice. Place your custom information on separate custom-named tabs.
{

Section Name: Enter in the name of the custom-related article information section.

{

Tab 1 Title: Enter in the name of the first tab.

{

Tab 2 Title: Enter in the name of the second tab.

{

Tab 3 Title: Enter in the name of the third tab.

{

Available Columns: Select the column data you want to display in a tab. Select a tab name in the Display Columns list box, then click the single
right arrow button to move the available column under the tab in the Display Columns list box. Use the Shift+Click or CTRL+Click keys to select
multiple columns in the Available Columns list box. Use the double right arrow button to move all available columns to the selected tab in the
Display Columns list box.

{

Display Columns: Lists the selected columns and their respective tabs. Use the up and down arrow buttons to move the columns up or down
within a tab. To add or remove a column from one tab to another, you must select the column, click the left arrow button to remove it from its
current tab, then select the new tab, select the column in the Available Columns list box and click the right arrow button.

For example, based on this configuration:

the custom related article information looks like this:

z

z

Use SMTP secure authenticated connection: Select this check box to enter in credentials for SMTP authentication.
{

User ID: Enter in the user ID.

{

Password: Enter in the password for the user ID.

{

Port: Enter in the port number.

Records per Page: Enter in the number of records to be displayed at a time in the Related Articles, Article Attachments and Related External

Links boxes.
z

Allow Article Rating: Select this option to show the Article Rating and Comments box at the bottom of the article content so that users may submit
their rating and comment on each article. If you select this box, you must select the rating system to use: Numerical or Star.
{

Numerical Rating or Star Rating: The Allow Article Rating option must be selected in order to select one of these options. Select the
Numerical Rating option to display a number rating system at the bottom of an article. Select the Star Rating option to display a graphical 5star-based rating system at the bottom of an article.

z

Hide Article Keyword(s) in Article Title Bar: Select this option to hide the article keyword(s) from the title bar of the article.

z

Hide Print Option: Select this option to prevent end users from printing articles.

z

Select a Language: Select this option to set the language used on the user interface of this Web Part. See Localizing SharePoint Knowledge Base
Solution Accelerator for more information.

3. Click Apply and then OK to save your changes.
TOP

Configuring the KB Tag Cloud Web Part
The Bamboo KB Tag Cloud Web Part allows end users to locate articles that have been viewed the most times by selecting a commonly used keyword (i.e. tag)
from the tag cloud.
To configure the Bamboo KB Tag Cloud Web Part :
1. From the KB Client site, click the Tag Cloud link. Edit the KB Tag Cloud Web Part.
2. Configure the Web Part:
z

Enter the site URL for the Bamboo KB Admin site: Enter the relative path to the KB Admin site and click the green arrow to populate the fields
below.

z

Select the KB Articles List: Select the Bamboo KB Articles List.

z

Select the KB Tag Cloud List: Selected the Bamboo KB Tag Cloud List.

z

Enter the URL to the page that contains the Bamboo Display Article Web Part for displaying article content: This field is prepopulated with the
relative path to the Bamboo KB Display Article Web Part.

z

Tag Format: Click

z

Number of Top Tags to Display: Enter the number of tags you want to display in the tag cloud. In the example screenshot above, only 20 of the most
viewed (i.e. top) tags will be displayed in the tag cloud.

z

Show Drop-Down Filter Menu: Select this check box to show a filter drop-down box that allows users to locate tags in the cloud by first letter of the
tag name.

z

Number of Related Articles to Display: Enter the number of related articles you want displayed after selecting a tag in the cloud.

z

Select a Language: Select this option to set the language used on the user interface of this Web Part. See Localizing SharePoint Knowledge Base
Solution Accelerator for more information.

to select a font type, style, color, background color, alignment, decoration, etc. in the dialog box.

3. Click Apply and then OK to save your changes.
TOP

Configuring the KB Search Web Parts
To configure any of the KB Search Web Parts (Article Search, Category Search, etc.), edit the Web Part, then click the KB Search Web Part Settings button in the
Web Part tool pane to display the Web Part Settings page.
Note: You must disable pop-up blockers for the site to display the Web Part Settings.

Click the links below for details about configuring the KB Search Web Part settings. When you are finished configuring the Web Part, click the Save & Close button
in the Web Part Settings page, then click Apply and then OK in the Web Part tool pane.
z

Search Criteria Configuration

z

Search Results Configuration

z

Look and Feel Settings

z

Language Settings

z

Online Resources and Customer Support

Search Criteria Configuration
Each instance of the KB Search Web Part can search one SharePoint list or library. In the Search Criteria Configuration settings page, identify the list or library
to search and define search criteria.

Select a List or Library to Search
1. Click Search Criteria Configuration in the Search Settings section of the KB Search Web Part Settings page.
2. In the Enter a SharePoint site URL box, type the path to the KB Admin or KB Client site that contains the list or library to search. For the KB Client Search
Web Part, the URL for the KB Admin site. The site can be part of any site collection in the Web application. Site URLs can be absolute (http://servername/site)
or relative (./site). Bamboo recommends using a relative URL if the Web application has multiple access points using Alternative Access Mappings (AAM) or if
the Web Part will be saved as part of a site template.
3. Click the View Lists and Libraries button to populate the Available Lists and Libraries drop-down list.
4. In the Select a list or library drop-down list, select the list or library to search in the KB Search Web Part. Make sure to select the correct list or library. For
example, to configure and search the Article Search Web Part, select the Bamboo KB Articles List.

5. KB Client Search Web Part only: In the Enter a URL to the page that contains the Bamboo Display Article Web Part box, enter the relative path to
the page that contains the Bamboo Display Article Web Part, for example ./SitePages/Display%20Page.aspx. This step is required in order to view KB articles.

Search Columns
Select the list or library columns you want to search. If you do not select any columns, the KB Search Web Part will only display a single field to search all columns.
z

To make a column searchable, select it in the Available Columns list on the left and click the > button to add it to the Selected Columns list on the right.
Hold down the SHIFT or CTRL key to select and move more than one column.

z

To add all columns to the searchable columns list, click the >> button.

z

To remove a column from the list of displayed columns, select the column or columns to remove and click the < button.

z

To remove all columns, click the << button.

z

To reorder the displayed columns, select a column and click the up or down arrows.

Search Criteria Join Operators
If search terms are entered in more than one column, the Search Criteria Join Operators selection determines how a match is found.

z

Select the OR operator to display items that match any search term.

z

Select the AND operator to display items only if they match all search terms.

Maximum Age
The Article Search and KB Client Search Web Parts have the option to set the maximum age for the search criteria. If this option is selected, users can choose the
maximum age of the item they are searching for. For example, users can choose to search for articles from the past 6 months, comments from the past 90 days, or
categories from the past 3 days.

Search Column Options
The KB Search Web Part can leverage the SharePoint Search service to allow searching in all list or library columns using a single search field. If SharePoint Search
is enabled and configured in your SharePoint farm, check the option Allow users to search all columns to add an additional field to the search criteria list called
Search in all columns for. If this option is not checked, only the columns selected in the Search Columns configuration section will be displayed. To display only
the Search in all columns for field, remove all other columns from the Search Columns list.
Note: In order for results to be found using the Search in all columns for field, the list configured in the KB Search Web Part must be included in the SharePoint
Search configuration. To test this, try searching for list data in the SharePoint Search page. If you see results from the list in SharePoint Search, you will get results
in the KB Search Web Part.
When the Allow users to search all columns option is checked, the following additional features define search behavior:
z

Search scope title: To improve search performance, enter the smallest SharePoint Search scope that includes the list data you want to search. Note: Search
scopes are only configurable in SharePoint Server 2010.

z

Include document content: Select this option to also search the text in list item attachments and document library items. Note: Only document types that
are indexed for SharePoint Search can be searched with the KB Search Web Part. For more information about searching documents, consult the documentation
for your SharePoint version.

Search Criteria Value Options
The following options define how default field values and choice settings are displayed:
z

Display default column value: For any SharePoint Single line of text column in the list or library that has a default value configured, the KB Search Web
Part will display the default value as the default search term when this option is checked. Note: This option currently applies to Single line of text columns only.

z

Disable lookup fields: Select this option to display the search box for SharePoint lookup columns as a text box instead of a drop-down list of choices. Bamboo
recommends disabling lookup fields if the lookup list has more than 200 items. Populating the drop-down list for large lookup columns can slow the
performance of the KB Search Web Part.

TOP

Search Results Configuration
The Search Results Configuration settings define how search results are displayed in the KB Search Web Part.

Search Result Display
Define the columns and view options for the search results grid:
z

Using existing list view: When this option is checked, the columns displayed in the search results, number of items displayed, and the item sort order will
match the settings configured for the list view selected in the Available List Views drop-down list. Note: Changing the list view configuration in the
SharePoint list will affect the search results display in the KB Search Web Part. Make sure to select the correct list or library. For example, select the KB Admin
Search Results List for the Article Search Web Part.

z

Define custom view options: If you prefer to customize search results display options specifically for the KB Search Web Part, select this option. Then select
the columns to be displayed, the number of items to display per page, and the item sort order. Changing list views for the SharePoint list will not affect how
search results are displayed in the KB Search Web Part.

Search Result Options
The following additional options are available to customize the search results page:
z

Display both search criteria and search results: When this option is checked, search results will be displayed below the search criteria. When the option is
unchecked, the search criteria will be replaced by search results.

z

Allow printing of search results: When this option is checked, the Print button is available on the search results screen.

z

Allow export of search results to Excel: When this option is checked, the Export to Excel button is available on the search results screen.

TOP

Look and Feel Settings
Look and Feel Settings define the look and feel of the KB Search Web Part, including color scheme, font, and layout.

By default, search criteria are listed vertically in the Web Part in a grid view. To customize the layout of the search criteria page, select Custom search criteria
layout, then click the Modify Layout button.

To modify the style applied to the search criteria page and the search results page, click the Modify CSS button.

TOP

Language Settings
To change the language used in the Web Part display and Web Part Settings page, perform the following steps:
1. If your preferred language is something other than English, customize or create a language file using the instructions provided in Localizing SharePoint
Knowledge Base Solution Accelerator.
2. Access the KB Search Web Part and click Language Settings in the Preferences section.
3. In the Select a Language drop-down list, select the desired language file.
4. Click the Save & Close button to save the Web Part settings.
5. In the Web Part tool pane, click Apply and then OK to view updates in the Web Part instance.

TOP

Online Resources and Customer Support
If you encounter difficulties or need assistance with the KB Search Web Part, read the information provided in the Help section of the KB Search Web Part Settings
page.

TOP

Using Relative Paths
Use the table below to determine how your relative paths will appear. Use relative paths, not absolute paths, when configuring the KB Admin and KB Client sites.
Site

Path

Is Equivalent To

Top Site (Root Site)

/SiteDirectory/KBAdmin/
or
~/SiteDirectory/KBAdmin/

http://servername/SiteDirectory/KBAdmin/_blank

Subsite (Current Web Site)

Lists/Discussion%20Board/
or
./Lists/Discussion%20Board/

http://servername/SiteDirectory/KBAdmin/Lists/Discussion%
20Board/_blank

Localizing Bamboo Products
Bamboo products can display user interface and tool pane text in your local language. To change the language a product displays, perform the steps described
below. Click a link below for detailed information about each step.
1. Customize a language file.
2. Select the customized language file in the product configuration.
Customizing Language Files
There are four language files included with Bamboo products:

z

1031.German.xml

z

1033.English.xml

z

1034.Spanish.xml

z

1036.French.xml

These files are located in the wpresources folder. This folder may be located under the following paths:
z

\\servername\drive\Inetpub\wwwroot\wss\VirtualDirectories\port\wpresources\[Product]

z

\\servername\drive\Program Files\Common Files\Microsoft Shared\web server extensions\wpresources\[Product]

The German, Spanish and French files have not yet been translated; they are still in English. Edit these files directly to provide your own translation of the product
user interface and tool pane text. To make sure that these files are not overwritten when you upgrade the product, copy the default file for the language you want
to the wpresources folder and rename it, for example: CompanyName.1036.French.xml. If you do not rename the files you modify, these files will be overwritten
when the product is upgraded.
To create language files for languages other than German, English, Spanish, or French, copy one of the existing language files and rename it. Then edit the file to
provide your own translation.
The installation program will not remove or overwrite translation files you have created if they are named differently from the default resource files included with
the product. However, product upgrades may require that you modify custom translation files to include new resource strings that were added for the new product
version. The product will display the missing resource string IDs after an upgrade is completed. Copy these resource string IDs from a default language file to your
custom translation file and make the appropriate changes for your language.
Selecting a New Language File for a Product
The instructions below for changing language file settings apply to Bamboo products with settings configured in the Web Part tool pane or Web Part Settings pop-up
page.
Changing Language Settings in the Web Part Tool Pane
1. Click the edit drop-down arrow on the Web Part title bar and select Edit Web Part.

2. In the Language settings section of the Web Part tool pane, select the language file you want to use.

3. Click Apply and then OK in the Web Part tool pane to apply your changes.

Changing Language Settings in the Web Part Settings Pop-up Page
1. From the Web Part, click the edit drop-down arrow on the Web Part title bar and select Modify Shared Web Part.

2. Click the [Product] Settings button in the Web Part tool pane.

3. Click Language Settings in the Web Part Settings page and select the language file you want to use.

4. Click the Save & Close button to save the Web Part settings.
5. Click Apply and then OK in the Web Part tool pane to apply your changes.
Using KB Accelerator
z

Using the Bamboo KB Admin Site

z

Using the Bamboo KB Client Site

z

Using the KB Search Web Parts

Using the KB Admin Site
The KB Admin site allows Knowledge Base administrators to view data about articles and authors, create new articles, manage existing articles, approve and
manage article comments, answer end-user questions, manage images, and create and manage Knowledge Base article categories.
The KB Admin site must be configured before it can be used. Read Configuring the KB Admin Site for information on configuring the KB Admin site.
Access the lists, libraries, discussion boards and other site content used in the KB Admin site by selecting Site Actions > View All Site Content and selecting the
desired item.
Click the links below for more information on each section.
z

Workflow Configuration List: Create customized buttons for the ribbon for workflow approval processes.

z

Reporting: View data and statistics about Knowledge Base articles.

z

Authors: View data about Knowledge Base articles according to author.

z

Pictures: Upload article- or category-related images.

z

Pending Questions: Answer questions submitted by end users.

z

Article Control: Create and edit articles. Manage article and category permissions.

z

Category Control: Create and edit article categories.

z

Comment Control: Approve and manage comments on articles.

z

Tag Cloud: Create tags to be associated with articles.

Workflow Configuration List
The Workflow Configuration List is part of the Workflow Start Feature optional component for users who have Workflow Conductor installed along with SharePoint
Knowledge Base Solution Accelerator, or users who wish to use out-of-the-box SharePoint workflows. Use the Workflow Configuration List to create buttons, located
in the ribbon, for workflows for automated processes such as article or comment approval or article publishing. See KB.12669: How to Use Workflow Conductor for
Process Automation in SharePoint Knowledge Base Solution Accelerator.
TOP

Reporting
The KB Admin site's Reporting feature allows Knowledge Base administrator to view data about Knowledge Base articles via charts, including:
z

Article Counts by Categories: Displays the current categories in the Knowledge Base along with how many articles are in each category

z

Article Counts by Article Type: Displays the article types along with how many articles are in each type

z

Article Usage Report: Allows Knowledge Base administrators to see which articles have the most views

z

Ask a Question Report: Displays how many questions have been asked, whether they were answered, and if Knowledge Base articles need to be created
based on the questions and answers

A data view is displayed underneath Article Counts by Categories and Article Counts by Article Type. This data view displays the number of articles in each category
or article type along with the average user rating for that category or article type. The Article Usage Report is a data view of the most popular articles and each
article's page views and rating. The Ask a Question Report is a bar graph that displays the number of questions submitted by users that:
z

Need a Knowledge Base article to be written

z

Do not have an answer

z

Have replies

To select colors for the chart, edit the Web Part. In the tool pane under Bamboo KB Reporting Configuration, click Choose colors for the chart. A new window
opens where you can select the desired colors for the chart. Choose your colors manually or click Auto Select to automatically assign colors, then click Save. To
change the chart skin (the background color), choose the desired skin from the drop-down list under Select a skin for the chart. To increase or decrease the size
of the chart, select the desired size under Choose a chart size.

Select Turn off chart labels to turn off the labels displayed in the chart. Select Show the Print and Export to Excel action buttons to display these options in
the Action button, located under the Web Part title. Click Apply and then OK to save your changes.

If the chart reduces in size after you select a different chart skin, choose Row instead of Column in the tool pane under Choose a legend display style.

TOP

Authors
The Authors section displays a data view of All Articles, which displays all articles in the Knowledge Base, or My Articles, which displays the articles authored by the
logged-in user. You can sort, filter, and make changes in datasheet view by selecting the Edit in datasheet option in the tool pane. For more information, see the
Data-Viewer online documentation.

TOP

Pictures
Use the KB Picture Library link under Pictures to upload and manage images for articles or categories. The KB Picture Library is a standard SharePoint picture
library.

To upload a new image:
1. From the KB Admin site, click KB Picture Library.
2. Click Upload and choose whether you want to upload one or multiple images. Select the file to be uploaded.

3. Use the form to update the image properties, if necessary. Click Save.

4. The image is now in the KB Picture Library.

To manage images:
1. From the KB Admin site Home page, click KB Picture Library.
2. Use the toolbar to manage the picture library:
z

New: Adds a new folder to the picture library to help you organize your images.

z

Upload: Uploads one or multiple images to the picture library.

z

Actions: Use this button to perform the following actions: edit images in an image editor, delete images, download images to your computer, insert
images in an e-mail or document, view images in a slide show, open the files with Windows Explorer, connect to Outlook, view RSS feeds or set up alerts
on this page.

z

Settings: Creates a new column or view; manages picture library settings.

TOP

Pending Questions
Pending Questions displays the Bamboo Article Questions and Answers List, which contains questions that end users have submitted to Knowledge Base
Administrators. Answer Questions is a data view of the questions that end users have submitted. It shows the number of replies for each question, the answer

status for the question, whether or not the question needs to be turned into a KB, and a list of available actions, such as Answer Question, Mark as Answered and
Edit.

These options allow Knowledge Base Administrators to better manage questions and answers to ensure that the Knowledge Base continues to be useful and
beneficial to end users. For example, a question that is submitted by many end users can be marked as Need KB since it is a popular question.
To edit or modify the Bamboo Article Questions and Answers list, edit the list settings. To do this, navigate to the list by selecting Site Actions > View All Site
Content > Discussion Boards > Bamboo Article Questions and Answers. Use the ribbon to edit the list settings by selecting List > List Settings. The list is
blank until an end user submits a question.
To answer a question:
1. From the KB Admin site, click Answer Questions.
2. Select Answer Question from the Available Actions drop-down list for the question that you want to answer.

3. In the Answer Question section underneath the data view, type your answer in the Answer field. Use the formatting options at the top to format text,
images and more. Use the Design option underneath the Answer field to edit in rich text format. Use the HTML option to edit in source code. Click Preview to
view how the answer will appear when it is submitted.

4. Click Send Answer to User to e-mail the answer directly to the end user. Click Answer Question to display the answer on the page with the question. Click
Close to cancel the reply.
To view replies:
1. From the KB Admin site, click Answer Questions.
2. The number of replies for each question are listed in the data view under Number of Replies.

3. To view the replies, select View Replies from the Available Actions drop-down list for the desired question.

4. A new window displays the replies in a discussion board.

To edit a question:
1. Select Edit from the Available Actions drop-down menu.
2. A new window displays the question in edit form.

3. Make the desired changes, then click Save.
To mark a question as answered:
1. Reply to the desired question.
2. Select Mark as Answered from the Available Actions drop-down list for the desired question.
3. The Answer Status automatically changes to Yes.

To mark a question as needing a KB:
1. Select Mark as Need KB from the Available Actions drop-down list for the desired question.
2. The status for Need KB automatically changes to Yes.

TOP

Article Control
Use the links under Article Control to create new articles, manage and edit existing articles, and manage article and category permissions.

The Create New Article link uses the Bamboo KB Articles List. To edit the columns used in the list, or to modify the options available in the list such as for
Article Type, edit the list settings. To do this, navigate to the list by selecting All Site Content > Lists > Bamboo KB Articles. Use the ribbon to edit the list
settings by selecting List > List Settings.
To create a new article:
1. From the KB Admin site, click Create New Article.
2. Create the new article:
z

Article Title: Enter a name for the article. This is a required field.

z

Related Articles: Add other articles that are related to this new article, if applicable. Click the related articles, then click Add. Click Remove to delete a
related article.

z

Article Keywords: Enter keywords that you want to be associated with the article, such as "SharePoint 2010," "installation" or "troubleshooting".

z

Article Type: Select the type of article. This list is prepopulated with the following options:
{

BUG

{

ERRDOC

{

ERRMSG

{

FAQ

{

FIX

{

HOTFIX

{

HOWTO

{

INFO

{

PROBLEM

{

RELNOTE

z

Related External Links: Enter any related links to this article, if necessary, for example: links to Microsoft TechNet.

z

Article Status: Choose the article's status, such as Draft, Under Review, Publish or Archived.

z

Review Date: Enter a date, or click on the calendar icon, to select a review date.

z

Article Category: Choose one or multiple categories for the article. Click Add to add the categories; click Remove to delete them. Use the CTRL key to
select multiple categories.

z

Article Text: Enter the text for the body of the article. Use the formatting options at the top to format text, images and more. Use the Design option
underneath to edit in rich text format. Use the HTML option to edit in source code. Click Preview to view how the article will appear when it is submitted.

z

Tag Term: Choose tags to be applied to the article. These tags will allow the article to be searched via the Tag Cloud on the KB Client site.

z

Expiration Date: Enter a date, or click the calendar icon, when the article will expire. This ensures that the Knowledge Base remains up to date and
current.

3. Click Save.

To change the width of the Related Articles and Article Category fields:
The width of the Related Articles and Article Category fields can be modified so that full article titles and categories are visible.

To modify the width:
1. Open the KB Admin site using SharePoint Designer.
2. Under Bamboo KB Articles and Bamboo KB Categories, open EditForm.aspx and NewForm.aspx.

3. From the ribbon, select Web Part Zone. (If this option is grayed out, use the ribbon to select Home > Advanced Mode.) Under Web Part, select Content
Editor.

4. Right-click on the Web Part and select Web Part Properties. Under Content Link, click
Click OK and save the page.

and browse to Shared Documents > Bamboo_KB_Articles.js.

5. Return to the KB Admin site. Click All Site Content > Shared Document Library. Click Bamboo_KB_Articles and save the file to the local drive (or the
desired location).

6. Use Notepad or the desired program to open the file. Change the value for the column width by modifying the value for var maxLimitWidth. The default value
is 250.

7. Save the file and upload it to the Shared Documents Library. The Related Article and Article Category fields now display the full article title or category.

To edit articles:
1. Click Article Control to locate the desired article, or click Manage Articles and use the search options to enter in your search criteria.

2. Click the Edit icon in the Update column to edit the article. A new window opens with the article in edit form.

3. Make your changes and click Save. Click Cancel to cancel the changes.
To manage article and category permissions:
The SharePoint Security Trimming Web Part allows Knowledge Base Administrators to set permissions for articles or categories in batches. This enables
Administrators to better manage and control articles and categories. For example, Administrators can set permissions for the category "Sales" so that only the Sales
Department can view articles in the "Sales" category. Or, Administrators can set permissions for article type "RELNOTE" so that only the Engineering and Product

Management departments can view articles under the category "Release Notes".
To manage article permissions:
1. From the KB Admin site's Quick Launch, click Manage Articles and Category Permissions.
2. Under Manage KB Articles Permission, enter the search criteria for the articles you want to manage permissions for, then click Search.
3. In the search results grid view, the color under the Security Type indicates the security level belonging to each article. Articles with the same color have the
same security level.

4. Select the desired articles and click Manage Permissions.

5. Select the user/group and choose one of the following:
z

Inherit Permissions

z

Grant Permissions

z

Edit User Permissions

z

Remove User Permissions

To manage category permissions:
1. From the KB Admin site's Quick Launch, click Manage Articles and Category Permissions.
2. Under Manage KB Category Permission, enter the search criteria for the category you want to manage permissions for, then click Search.
3. In the search results grid view, the color under the Security Type indicates the security level belonging to each category. Categories with the same color have
the same security level.
4. Select the desired articles and click Manage Categories.

5. Select the user/group and choose one of the following:
z

Inherit Permissions

z

Grant Permissions

z

Edit User Permissions

z

Remove User Permissions

TOP

Category Control
Use the Add New Category and Manage Categories links under Category Control to add new categories and manage or edit existing categories.

The Add New Category link uses the Bamboo KB Categories List. The list is prepopulated with data that you can modify. To edit the columns used in the list,
edit the list settings. To do this, navigate to the list by selecting Site Actions > View All Site Content > Lists > Bamboo KB Categories. Use the ribbon to edit
the list settings by selecting List > List Settings.
To add a new category:
1. From the KB Admin site, click Add New Category.
2. In the New Item form, enter the name of the new category (required); a parent category (such as Announcements & News or Articles, Tips & Tricks) to be
associated with the category, if desired; and an image URL, if necessary.

3. Click Save.
4. The new category is added to the Bamboo KB Categories list. It is displayed in the KB Tree View on the KB Admin site home. View the new category by clicking
Category Control.

To manage categories:
1. From the KB Admin site, click Manage Categories.
2. Enter your search criteria and click Search.

3. Click the Edit icon under the Update column to edit a category. A new window displays the category in edit form.

4. Make your changes and click Save.
TOP

Comment Control
Use the Approve & Manage link under Comment Control to approve and manage comments submitted by end users about Knowledge Base articles.

The Approve & Manage link uses the Bamboo KB Rating and Comments List. To edit the columns used in the list, edit the list settings. To do this, navigate to
the list by selecting Site Actions > View All Site Content > Lists > Bamboo KB Ratings and Comments. Use the ribbon to edit the list settings by selecting
List > List Settings.
Warning: If you are using workflows to approve and manage comments, do not manually approve comments. Doing so will stop the workflow task from approving
comments, and the Workflow Task List will display open tasks. Choose to approve comments using only one method (workflows or manual approval).
To manage comments:
1. From the KB Admin site, click Approve & Manage.
2. Enter your search criteria and click Search.

3. To publish the comment, click Publish. To edit the comment, click the Edit icon under the Update column. A new window displays the comment in edit form.
z

Use Article ID to assign a different ID to the comment. This is a required field.

z

Change the Rating using the drop-down list.

z

Modify the Comments in the rich text editor. Use the formatting toolbar to format your text.

z

Change the Status of the comment to Submitted, Rejected or Published.

z

Associate the comment to another Article Title using the drop-down list.

4. Make your changes and click Save.

TOP

Tag Cloud
The Bamboo KB Tag Cloud List allows Administrators to add new tags to be associated with articles. End users on the KB Client site can then view a tag cloud to
view articles associated with that tag.
To add tags to the Bamboo KB Tag Cloud List:
1. From the KB Admin site, click All Site Content.

2. Under Lists, select Bamboo KB Tag Cloud.
3. Click Add new item to add a new tag to the list. Click Save.
TOP

Using the KB Client Site
The KB Client site enables end users to search for articles and content; print or e-mail articles or export them to PDF; submit questions to Knowledge Base
Administrators; rate and comment on articles; view the most popular and recently added articles; and more. You must configure the KB Client site before you can
begin using it. Read Configuring the KB Client Site for information on configuring the KB Client site.
Before you can use the KB Client site, you must create articles in the KB Admin site. Read Using the KB Admin Site for information on using the KB Admin site.
Click the links below for more information on each section.
z

Home (to locate articles and to view the most popular and most recently added articles)

z

Search (to search for articles using specific search criteria)

z

Ask a Question (to submit questions to Knowledge Base Administrators)

z

Tag Cloud (to view specific articles using tag terms)

Home
The Home page displays a tree view of articles that allow users to search for articles.
The sections for Most Popular Articles, Latest Additions and All Articles can be hidden. The tree view can also be hidden. To hide one or all of these options,
edit the Web Part. In the configuration tool pane, uncheck the options that you want to hide. Click Apply and then OK to save your changes.

To view any of the articles in the Most Popular Articles, Latest Additions and All Articles sections, simply click the article title to view it.

The article's title and content are displayed. Keywords associated with the article are displayed above the article title. On the right side of the page, view when the
article was created and last modified as well as who last modified the article. See how many times the article has been viewed and what the article rating is. You
can also print or e-mail the article. Underneath the article, you can rate the article and submit comments. You can also view related external links associated with
the article. Under Additional Article Details, you can view the article type, tag terms associated with the article, the date that the article was last reviewed, and
the categories associated with the article.

Use the tree view to view articles by expanding or collapsing the categories to view subcategories. The Most Popular Articles, Latest Additions and All Articles
sections then display that category's most popular articles, most recently added articles and all articles.

TOP

Search
The Search page allows end users to search for articles using specific search criteria. See Using the KB Search Web Parts for more information about searching and
search criteria.
To search for an article:
1. From the KB Client site Home page, click Search.
2. Enter in your search criteria and click Search.

3. Click the article title to view the article. Click Print to print the article or Export to Excel to export it.
TOP

Ask a Question
The Ask a Question page allows end users to submit questions to Knowledge Base Administrators, who can then review the questions and respond to them. Read
Using the KB Admin Site for more information on answering questions.
You can modify the instructive text that appear on this page according to your organization's needs. For more information, read Configuring the KB Client Site.
To submit a question:
1. From the KB Client site, click Ask a Question
2. Fill out the form with your name, e-mail address, subject and question.

3. Click Submit Question.

The question is submitted to the Knowledge Base Administrators through the Pending Questions section in the KB Admin site. The Knowledge Base Administrator
can e-mail the reply to the question directly to the user from this section. For more information, read Using the KB Admin Site.
TOP

Tag Cloud
The Tag Cloud page allows users to search for articles using tag terms. Users can select the most viewed articles by selecting the largest tag term in the tag cloud.
Tags must be created in the KB Admin site. See Using the KB Admin Site for more information.

Use the drop-down list to search for specific tags. Click a tag to view all articles associated with that tag.

A larger tag size indicates a greater number of articles associated with that tag.
TOP

Using the KB Search Web Parts
The following topics provide examples of using KB Search Web Part with different search options:
z

Simple Searching

z

Viewing Search Results

z

Printing and Exporting Search Results

z

Searching Multiple Columns

z

Searching Using AND, OR or MINUS

z

Searching in All Columns

Simple Searching
To perform a search with the KB Search Web Part, simply enter search terms in one or more search criteria fields and click the Search button. The example below
shows a search for published articles created in the last 3 days that contain the keywords "My Bamboo," "licensing" and "activation keys."

TOP

Viewing Search Results
Search results are displayed in a grid view according to how the KB Search Web Part is configured. Search results will either be displayed below the list of search
criteria or will replace the search criteria, depending on the option configured in the Web Part settings. The columns shown in the search results may correspond to
an existing list view or may have been customized when the Web Part was configured. The columns displayed may be different from the columns that can be
searched.

If there are more search results than can be displayed on one page, use the paging links at the bottom of the search results grid to move between pages of results.
The maximum number of items per page is configured in the list view if results are displayed using an existing view or in the Web Part settings if custom view
options are configured.
Click any column heading to sort the results by that column. Click again on the same heading to reverse the sort order. Default sort order is configured in the list
view if results are displayed using an existing view or in the Web Part settings if custom view options are configured. Note: This feature is not available for
SharePoint Search results view.

To view the details for an article, click the article title. A new window displays the article in view form. To view the details for a category or comment, click the item
link. The item will be displayed in a new page. Note: The search results view must include a column with the linked to item option.

Note: You can perform additional item actions (edit, delete, etc.) using the item edit menu. The search page will be reset when you perform item actions using the
edit menu.

TOP

Printing and Exporting Search Results
If the options to allow search result printing and exporting are enabled in the Web Part settings, the Print and Export to Excel buttons are available in the search
results page.
Click the Print button to format search results for printing and send them to your printer.

Click the Export to Excel button to export search results to a Microsoft Excel spreadsheet.

TOP

Searching Multiple Columns
You can search in more than one field at a time by entering values in multiple search criteria fields. Depending on which option was selected when the Web Part was
configured, search terms will be joined with either the OR or AND operator. With the OR operator, items will be displayed in the search results if they match any of
the search terms. With the AND operator, items will be displayed in the search results only if they match all search terms. Contact your SharePoint administrator if
you are not sure which option is configured for the Web Part.
Searching Using AND, OR or MINUS
Users can search for multiple criteria in the same field using AND, " " or +. In the examples below, the terms "Troubleshoot" and "Farm" are used to search for
articles. The results are the same regardless of how the search terms are entered.

Users can search for multiple criteria in the same field using OR or a space. In the examples below, the terms "PowerShell" and "SharePoint 2010" are used to
search for articles. The results are the same regardless of how the search terms are entered.

Users can omit specific criteria when searching by using the minus sign (-). In the examples below, articles that include "Bamboo" but do not include "2010" are
displayed by entering Bamboo -2010 for the search string.

TOP

Searching in All Columns
If the Allow users to search all columns option is selected in the Web Part settings, a field called Search in all columns for will be displayed in the KB Search
Web Part. Enter one or more search terms in this field to search text in all columns of the SharePoint list or library. This search fields leverages the SharePoint
Search service and requires that SharePoint Search be enabled and configured. For an item to be found using the Search in all columns for field in the List Search
Simple Web Part, you must also be able to find it in SharePoint Search.
Note: Entering search terms in the Search in all columns for field overrides any search terms entered in other search criteria fields. The Search Criteria Join
Operator setting does not apply to this field.

The following additional Web Part settings affect how the Search in all columns for field and its results are displayed:
z

Include document content: When this option is selected, item attachments and document library items that are indexed in SharePoint Search will also be
searched.

z

Use SharePoint Search results view: When this option is selected, search results are displayed using the same columns displayed in SharePoint Search
results. This option overrides any list view or custom view display options that are configured in the Web Part.

TOP

About Licensing
For trials, no license key is required. For more information on our licensing, refer to http://store.bamboosolutions.com/BambooMainWeb/FAQ.aspx.
Once purchased, the product licensing is controlled through a separate license key and activation program installed on the server where SharePoint Central
Administration is installed. To license Bamboo products, you must:
1. Install the Bamboo Web License Manager on the SharePoint server where SharePoint Central Administration is installed (just install one time - not for each
product that you install).
2. From Bamboo Web License Manager, locate the product you want to activate, enter in your license key(s) and activate the product on the servers where you
want the product to run - all from one place. You can activate the license online or via email.
You can also check the licensing status of Bamboo products you installed to determine whether a product trial will soon expire or whether the product has been
deactivated or not.
You must be a machine and SharePoint Farm administrator to install and run the Bamboo Web License Manager.
Installing the Bamboo Web License Manager
1. On the server where SharePoint Central Administration is installed, then from the Setup program screen, click the Bamboo Web License Manager component
button, then click Install.
2. Read the End-User License Agreement and choose to accept or abort the install.
3. Click Next to continue.
4. The program performs some system checks to determine whether your server is ready for installation. Click Next to continue.
5. The program is restricted to only install the Bamboo Web License Manager on the server where it detects the SharePoint Central Administration has been
installed. This web application should already be selected for you as well as the Automatically activate features check box. Click Next to continue.
6. The Bamboo Web License Manager is then installed on the server. Click Next to view a details screen of the installation.
7. Click Close.
Note: If you encounter any issues with the installation, please reference our Knowledge Base for help and troubleshooting.

Licensing and Activating the Web Part
1. Open SharePoint Central Administration (make sure you have the proper access rights to log in). Notice the Bamboo Solutions heading at the bottom of the
page.

2. Under the Bamboo Solutions section, click Manage My License Keys.
Note: If you have not yet installed any Bamboo products, the Web License Manager will not show any products. If you have installed Bamboo products that
support the new Web Licensing Manager prior to installing the Bamboo Web License Manager, you will need to uninstall those Bamboo products and reinstall
them in order to manage them in the Bamboo Web License Manager. This is optional. Your licensed Bamboo products will continue to run regardless of whether
they show in the Web License Manager.
3. Expand the Individual Products section or the Suites section (depending on the product/suite you want to license), locate your product, and click the product
name to view the license status or click the drop-down arrow to Activate/Deactivate or view the Status.

4. Do one of the following:
z

If you want to activate the product without viewing the status, click Activate/Deactivate from the drop-down (see screenshot above).

z

If you choose to view the licensing Status, then click the status to activate or deactivate the license.

5. Do one of the following:
z

To activate online, type or copy and paste the license key into the field provided and click Activate.

z

To activate by email, enter the license key and select the Activate by E-mail check box, then click Activate.

6. If you choose to activate by email, click the support@bamboosolutions.com email address and send the License Key and Machine Key to Bamboo Support.
Our Support Team will reply with an activation key that you will then type into the boxes provided. Then click Activate.
7. Your product has now been activated and is ready for use.

8. Optional Step: Click the Choose License Server(s) link. This page allows you to select all the web front end servers you may want to install Bamboo
products on. However, this is optional. Please read the license servers page to determine your selections. Click OK, after you have made your selections.

